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Cycle 3 Capabilities

At least 36 x |12-m antennas, plus 10 X 7-m antennas (for short baselines)
and 2 X 12-m antennas (for zero-spacing)
Receiver bands 3,4, 6,7,8,9, & 10 (wavelengths of about 3.1 to 0.35 mm)
Baselines up to 2 km for Bands 8, 9 and 10
* up to 5 km for Band 7, and
* up to 10 km for Bands 3, 4, & 6
Both single field interferometry and mosaics of up to 150 pointings
* Spectral-line observations with all arrays and continuum observations with the 12-m
Array and the 7-m Array. Single dish use will be limited to spectral line observations
in Bands 3 to 8.
* Polarization (on-axis, continuum in Band 3, 6 and 7, no ACA, no mosaics, no spectral
line, no circular polarization)
* Mixed correlator modes and multiple spectral windows (both high and low frequency
resolution in the same observation)
* The maximum observing time per proposal, as estimated by the OT,is 100 hrs.

-~



Be mindful of configuration schedule

Start Dates Configuration |Night LST Not recommended
2015 October 1 C36-8 ~17h - 9h High frequency projects especially
during day time (LST ~10h-16h)
2015 November 10 C36-7 ~19h - 11h High frequency projects especially
during day time (LST ~12h-18h)
High frequency projects any time,
201.5 Decembe.r 29 C36-1 ~00h - 16h specially during day time (LST
(Maintenance in February) ~17h-23h)
- i High frequency projects day time
2016 March 22 C36-2 04h - 20h (LST ~21h-03h)
. i N ) High frequency projects day time
2016 April 19 C36-3 07h - 23h (LST ~00h-06h)
- i High frequency projects day time
2016 May 10 C36-4 08h - 00h (LST ~01h-07h)
- i High frequency projects day time
2016 May 31 C36-5 10h - 02h (LST ~03h-09h)
2016 July 5 C36-6 ~13h - 05h High frequency projects especially
y during day time (LST ~06h-12h)
High frequency projects especially
2016 August 30 C36-7 ~16h - 08h

during day time (LST ~09h-15h)

Notes for Table 3: Dates include relocation time at the end of every configuration

ALMA




Once you have done this...

You are here: Home > Propesing » Observing Tool

Observing Tool

Proposing The ALMA Observing Tool (OT) is a Java application used for the preparation and submission of ALMA Phase | (observing proposal) and Phase Il
(telescope runfiles for accepted proposals) materials. Itis also used for preparing and submitting Director's Discretionary Time (DDT) proposals. The
current Cycle 1 release of the OT is configured for the Early Science Capabilities of ALMA as described inthe Cycle 1 Call For Proposals. Note thatin
Road Map order to submit proposals you will have to register with the ALMA Science Portal beforehand.

About

Call for Proposals

Sensitivity Calculator .
y Download & Installation

DDT proposals The OT will run on most common operating systems, as long as you have Java 6 installed (see the troubleshooting page if you are experiencing Java
Obsenving Tool problems). The ALMA OT is available in two flavours: Web Start and tarball.
Web Start Download The Web Start application is the recommended way of using the OT. It has the advantage thatthe OT is automatically downloaded and installed on your

computer and it will also automatically detect and install updates. There are some issues with Web Start, particularly that it does not work with the Open
JDK versions of Java such as the "lced Tea" flavour common on many modern Linux installations. The Sun/Oracle variant of Java should therefore be
Tarball Download Page  jnstalled instead. If this is not possible, then the tarball installation of the OT is available.

OT Video Tutorials

Page

The tarball version must be installed manually and will not automatically update itself, however there should be no installation issues. For Linux users,

Troubleshooting we also provide-s saended version of the Java run time environment. Please use this if you have any problems running
) the-OT tarball install with your default Java.
Observing
Data | WebStart | Tarball

Documents & Tools

Knowledgebase/FAQ Extensive documentation is available to help you work with the OT and optimally prepare your proposal:

e |fyou are a novice OT user you should startith the OT Quickstart Guide, which?akes you through the basic steps of ALMA proposal preparation.
User Services at
ARCs

e Audio-visualillustrations of different aspects ofthe OT can be found in the OT video tutorials. These are recommended for novices and advanced

users alike.

Helpdesk
- P e Kore in-depth information on the OT can belfgund in the User Manual, while cop2ise explanations of all fields and menu items in the OT are given in
= EU ARC

the Reference Manual. These Dvo documents are also available within the OT under the Help menu.
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The upper part of the proposal cover

Cycle3-RC2) - Really catchy title here

page is where you define the proposal:
Title, Abstract, Category, Keywords, note

Perspective 1

related/previous proposals ... y

¢ @ Proposal 7| Proposal Title =———2>Really catchy title here

(=3 Planned Observing Proposal Cycle C3UT.1

[Not too abstract, please

; Abstract
(max. 1200 characters)

Launch Editor
3 ® Standard

Proposal Type

Scientific Category

- Cosmology and the High
® Redshift Universe

Circumstellar disks,
) exoplanets and the solar
system

) Target Of Opportunity

. Galaxies and Galactic o ISM, star formation and
Nuclei astrochemistry

. Stellar Evolution and the
' Sun

Lyman Break Galaxies (LBG)
Starburst galaxies

Sub-mm Galaxies (SMG)

High-z Active Galactic Nuclei (AGN)

Keywords
(max. 2 keywords)

Lyman Alpha Emitters/Blobs (LAE/LAB)

»

4

Student project O

Continuation []

Related Proposals

Previous Proposals

Investigators

[ »

i




Further down, SeleCt PI/CO'I,S frOm a\ving Tool (Cycle3-RC2) - Really catchy title here

search of registered ALMA users I Perspeciive 1
and attach the Science Case from 1] 21
a .pdf on disk

n-dsmology and the High - Galaxies and Galactic ~ ISM, star formation and =]
2 . ) L
¢ [ Really catchy title here " Redshift Universe " Nuclei " astrochemistry
¢ G Proposal 552 Circumstellar disks, )
(=7 Planned Observing ) exoplanets and the solar gzer:lar Evolution and the
% system

Lyman Alpha Emitters/Blobs (LAE/LAB)
Lyman Break Galaxies (LBG)

Starburst galaxies

Sub-mm Galaxies (SMG)

High-z Active Galactic Nuclei (AGN)

L ]»

Keywords
|l (max. 2 keywords)

I

555 Student project O Continuation [

Related Proposals

5§; Previous Proposals

Investigators

Science Case will be a PDF
;é with a max of 4 pages,
800 ' | including figures.

Investigator search constraints
AMA D |+ | s [hiiszt |

Find Investigators I

Type Full name Email Affiliation
Pl Not set Not set Not set

Full name Email Affiliation ALMA ID
Harvey Liszt hliszt@nrao.edu North American ALMA ... |hliszt \

[SelectPI... | I Add Col... H Remove Col I‘ I Add from Proposal... l

Select PI Cancel I




File Edit View Tool Search Help Perspective 1
[0]a] [¢[n) [o]a] @) * |a = (@] 2] o]
Project Structure 4:|Editors
Proposal | Frogram | (‘Spectral | Spatial | Project |
Unsubmilted Proposal Z Principal Investigator
¢ = Project 2]
o f@ Proposal ::; 0\
\ SelectPl...
Main Project Information
(2]
Project |
Assigned Priority

Project Code None Assigned

- ‘ I

A clean slate. From here, you can:

. Start a new proposal TVaIidation History | Log | [
» Add blank Science Goals (SG) Description Suggestion
» Load templates with example SG

Contextual Help

1. Please ensure you and your co-Is are registered with the ALMA New
Science Portal Science
2. Create a new proposal by either: il pr
@ Selecting File > New Proposal
@ Clicking on the £ icon in the toolbar

-
@ Or clicldngﬁon this link Imporing Template Need
3. Click on the & proposal tree node and complete the relevant ggorﬂn g Library H:{S?

‘ | fields.

H
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Project - Observing T
Edit View Tool Search Help

ew Proposal Ctrl-N 2 B | [ li'
New DDT Proposal Ctrl-D

Perspective 1

Open Project »
Save Ctrl-S

Save As... =
=i Show ALMA Template Library

Use Project as Template SelectPl...
U iEs Lims Main Project Information

Submit Project [2]

Project |

Preferences \

Assigned Priority
Project Code None Assigned

Quit

Validation |  Validation History | Log |

Suggestion

Contextual Help

1. Please ensure vou and your co-Is are registered with the ALMA New
Science Portal Science
2. Create a new proposal by either: LT
@ Selecting File > New Proposal
® Clicking on the & icon in the toolbar
@ Or clicking on this link
3. Click on the & proposal tree node and complete the relevant
fields.

Click on the overview steps to view the contextual help




Perspective 1

O/m|m @@III

Spectral [“Spatial | Proposal |
Proposal Information

| »

Proposal Title |
Proposal Cycle 2015.1

| Abstract
|| (max. 1200 characters)

Launch Editor

Proposal Type
{0 Standard {2 Target Of Opportunity

Scientific Category

<] o Cosmology and the High o Galaxies and Galactic o ISM, star formation a
@ Redshift Universe Nuclei astrochemistry —

Circumstellar disks,
) exoplanets and the solar
system

x
|Cycle3 Template Library (read-only)
¢ [& Cycle3 Template Library
¢ & Proposal
¢ [ Planned Observing

o= ScienceGoal (810 12CO,
ScienceGoal (B3 CO,
ScienceGoal (B3 90 G s kinmatics ense
ScienceGoal (B3 single-point spectral sweep
ScienceGoal (B4 TOO_GRB)
ScienceGoal (B6 CO, 13CO, C180 (all J=2-1
ScienceGoal (B6 12CO (2-1): NGC3256 mos
ScienceGoal (B7 12C0O, HCO+, HCN)
ScienceGoal (Comet B7 CO, HCN, CH30H, N
ScienceGoal (B7 Continuum: Pluto/Charon)
ScienceGoal (B7 Polarisation observations of
ScienceGoal (B8 Double mosaic )
ScienceGoal (B8continuum: Cosmic
III

O Stellar Evolution and the
Sun

Related Proposals

LA O A A A O A 4
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AgT Template library. Turn the keys on the JTree below & read the c
File Edit View Tool Search Help Perspective 1

OIENEIEN IR NEIEEHE)

b
Proposal [ Program | “|[ Spectral | Spatial | ScienceGoANBETZCT
Unsubmitted Proposal A General (Optional)
¢ (= Project
o G Proposal Science Goal Name B6 12C0 (2-1): NGC3256 mosaic

This is a project to cbserve the nearby starburst galaxy NGC3
band 6 in the emission line of 12C0 (2-1). As the source is €
mosaic will be used to cover the 30x30 arcsec area of intereg

Description

s

ﬁunch Editor

I — ]
Template library. Turn the keys on the JTree below & read the d... [X] NGC3256 /
: Source

¢ @@ Proposal
¢ [ Planned Obs

NGC3256
Object? [] Name of objectlUnspeciﬁed

?

ScienceGoal (B7 continuum: GRB ToO: days
ScienceGoal (B6 continuum: GRB ToO: day 1
ScienceGoal (B3 continuum: GRB ToO: day 3
iScienceGoal (B6 12CO (2-1): NGC3256 mos

Contextua Help  Phasebscenceproposs

Description Suggestion

LA A A A A A 4




Spectral [ Spatial | Field Setus

y -

Source Nagg Nccazse [/

¢ & Project
¢ @@ Proposal Se
¢ [ Planned Observing )
i Sexagesimal
¢ [ scienceGoal (Copy of B& 12CO (2-1): N¢ J2000 - ?' Parallax [0.00000

[ General - - —

10:27:51.6000
-43:54:18.000 PM DEC |0.0000

Name of object|Unspecified

Source Radial Velocity

Target Type
Expected Source

Peak Continuum Flux Density per Beam|0.17400

Conti{}um Polarization Percentage 0.0 |26

Peak Line Flux Density per Beam |0.00000 |Jy | v I
Line Width I0.00000 |kmls | VI

Line Polarization Percentage

Coords Type () ABSOLUTE ® RELATIVE
System 142000 v
Field Center

Coordinates Ofrset(Longitude)I0.00000 |arcsec | v I
Offset(Latitude) I0.00000 |arcsec | v I

Description Suggestion




File Edit V

iew Tool Search Help

Proposal | Program |

Bjnjaja) ¢ = o/ @ *

[+/5[Cla/s @] ]e5] o]

v = Observing Tool for ALMA Cycle3 Groun
¢ (& Proposal
¢ [ Planned Observing
? . ScienceGoal (Science Goal)

[ General
[ Field setup
D Spectral Setup
[ calibration Setup
[T control and Performance
[Ty Technical Justification

| i |

[ —
Template library. Turn the keys on the JTr...
¢ [ Template library. Turn the keys on th
¢ (& Proposal

¢ [J Planned Observing
ScienceGoal (B3 spectral sy
ScienceGoal (B7 continuum
ScienceGoal (B7 CO(9-8): (
ScienceGoal (B9 continuum| =
ScienceGoal (B3 spectral sv
ScienceGoal (B3 continuum
ScienceGoal (B6 continuum
ScienceGoal (B7 continuum
ScienceGoal (B6 continuum
ScienceGoal (B3 continuum| |
ScienceGoal (B6 12CO (2-1
ScienceGoal (B6 13CO (2-1
ScienceGoal (B6 spectral Ii:l
ScienceGoal (B9 spectral li
ScienceGoal (B3 continuum

?

SR A A A A 4

i ) LD

ScienceGoal (B6 continuum|—

Perspective 1

'@EfSDECtraI [ spatial |  Field Setup |
:55 anti-bllac
Source

][]
" Resolve I

|anti-b|lac
Choose a Solar System Object? []

Source Name

Name of object |Unspeciﬁed

Sexagesimal parallax 0.0 mas |w

_ System display? [v] |—l—|
Source Coordinates RA 22:02:43.2912 PM RA |0.00000 |mas/yr Iv
Dec  |-42:16:39.978 PM DEC |0.00000 |mas/yr |v

Source Radial Velocity

0.000 km/s | w|[hel [+ z[0.000000000 DoppIerTvpe

Target Type

® Individual Pointing(s) ' 1 Rectangular Field

Expected Source Properties

Field Center Coordinates

Custom Mosaic: | |

Dffset []
Offset Unit |arcsec | |
#Pointings [2
RA Dec
22:02:44.2910 -42:16:39.978
22:02:43.2910 -42:16:39.978
| Add H Delete H Import H Export |

Add Source | Load from File... I Export to File... I Delete Source | Delete All Sources

| »

Il




New: Put a mosaic around more than one field source

’ i i ; T T ———— 3
RQT Project - Observing Tool for ALMA, version Cycle2Test2 (RN s= |
File Edit View Tool Search Help ‘Perspec’(ive1
AD & = G B Yk | @
Project Structure : Editors . . a0
(Proposal | Program Spefral | Spatial | Fiel Sea The Spatial tab gives a graphical
Unsubmitted Proposal ; ISR visualization of the Field Setup. PMRA [0.000[4]
¢ B Project /f
¢ & Proposal e PM DEC [0.000
¥ (=l Planned Observing Source Radial Velocity [2794.200 z[0.009364201 |
? E ScienceGoal (Cop
E’] General Target Type ) Individual Pointing(s) ® 1 Rectangular Field
[ Field Setup Expected Source Properties ]
E] Spectral Setup

[ calibration Seﬁ
D Control and Pe
D Technical Just#

Peak Continuum Flux Density per Beam|0.17400

Continuum Polarization Percentage (0.0

Peak Line Flux Density per Beam |0.00000

Line Width |0.00000
Line Polarization Percentage |0.0

@% @ (=] @[ [ 244139 [ 129190

Rectangle =
10:27:56.867, -43:56:54.93 (J2000)
4 M » Image Filename ~emijan\jsky3\cache\jsky9043341093951517820 fits
[ [] .
= Select a background image
Template library. Turn the keys o...[ X] FOV Parameters . .
i L M = T2 R LT HS from an online Image server
¢ @@ Proposal Representative Frequency (Sky) 231.546 GHz
|j Planned Observmg 3 Antenna Diameter ®12m O 7m
o- %4 ScienceGoal (B~ UNSENCS
o [88 scienceGoal ( Antenna Beamsize (HPBW) 26.706 arcsec
o (588 ScienceGoal ( Show Antenna Beamsize p length 00000
o- [seil ScienceGoal ( Image Query - ‘
o B encecoal glength  [2.00000 ||
o- [&88 ScienceGoal ( it ;
g = Image Server ’D|gmzed Sky (Version Il) at ESO Position Angle|0.00000 ‘ deg =
o= ScienceGoal ( ‘
o I8 scienceGoal ( Image Size(arcmin) [10.0 ’ Query \ [ =]
— Snari n.42112 | F3 Rocot/ Y|
| o—I 58N ScienceGoal (Ei:J‘ q] m nacina ® E o C O
< I »| —
Overview «
Contextnal Heln Phase I Science Pronnsal ll.l -




New: Put a mosaic around more than one field source

ﬂn’l’ Project - Observing Tool for ALMA, version Cycle2Test2

.

X

‘1

[ Proposal

File Edit View Tool Search Help
- B = E B Ykl | ®
Project Structure : Editors

Unsubmitted Proposal
? = Project
¢ & Proposal
¢ [C] Planned Observing
? E ScienceGoal (Cop
D General
[ Field Setup
D Spectral Setup
[ calibration Set
[y control and P¢
[ Technical Justi

[»]

Template library. Turn the keys o...[X]
[Y = TEmpIdE nordary. ranmure HT

¢ @@ Proposal —
¢ [ Planned Obsening

228 ScienceGoal (B=

ScienceGoal (

[«

o

Overview

v Spatial Image

" spatial | Field Setup

‘ Perspective 1

Or load a local fits image

NGC3256

Source

.....

Source Name

Target Type

@ [ | 71,52

0.0
Rectangle

l@k%@

Image Filename -emijan\.jsky3\cache\jsky9043341093951517820 fits

10:28:13.821, -44:00:03.43 (J2000)

Choose a Solar System Object? [_]

Source Coordinates

Source Radial Velocity

’NGC3256

Sexagesimal

" J2000 ‘V —
SlStem’ | display? |v|

RA
Dec

’ 10:27:51.6000

-43:54:18.000

) Individual Pointing(s) ® 1 Rectangular Field

Expected Source Properties

Peak Continuum Flux Density per Beamv0A17400 | [Jy
Continuum Polarization Percentage VO.O

Peak Line Flux Density per Beam vOAOOOUU | [Jy
Line Width 'OAOOOUU

Line Polarization Percentage VO.O

Name of object|Unspecified

Parallax 0.000
PMRA [0.000

PM DEC |0.000

2794.200 km/s | ¥ | |hel |w| z|0.009364291 |=

| |kmis || |

[»]

~

Coords Tyi%[.n ABSOLUTE @ RELATIVE

You can turn “on/off”’ the mosaic beam

pattern using this button.

Each circle is the size of the primary beam,
\_centered on the field center

System ]Jzooo

Offset(Longitudej:‘ODUOOO

Az;w_u_r-.iﬁw.lw

| |arcsec ‘

il [l

‘v‘

»

/




New: Put a mosaic around more than one field source

RQT Project - Observing Tool for ALMA, version Cycle2Test2

T —_—

23

[F= =

"‘

File Edit View Tool Search Help

- = | =|E i A=l | @
Project Structure : Editors
[ Proposal I [ Spatial Field Setup

Unsubmiited Proposal
W Project
¢ B Proposal
¢ [C] Planned Observing
? E ScienceGoal (Cop
D General
[ Field Setup
E] Spectral Setup
[ calibration Set
D Control and Pe
D Technical Justi

(<] Il |

[*]

Template library. Turn the keys o...[ X]
L& TEIMpTae ToTary. TunT e L |

¢ @@ Proposal
¢ [J Planned Obsenving

«

-

Or load a local fits image

‘ Perspective 1

Spatial Image

.....

.....

@ @ (=] @[ x| 388 468
[ 10:27:42.245, -43:5124.64 (J2000)

Image Filename -emijan\.jsky3\cache\jsky9043341093951517820 fits

13678.0

FOV Parameters

| NGC3256

Source

Source Name

Source Coordinates

Source Radial Velocity

Target Type

Rectangle

’NGC3256

Choose a Solar System Object? [_]

System [J2000 | ¥

Name of object|Unspecified
Parallax |0.000

Sexagesimal

displsy'-’[ﬁ
RA [ 10:27:51.6000 . 000
Dec  |-43:54:18.000 | PM DEC [0.000
2794.200 | ks v[ hel v[ z[0.009364291 |

) Individual Pointing(s) ® 1 Rectangular Field

Expected Source Properties

Continuum Polarization Percentage

Peak Line Flux Density per Beam

Line Width

Peak Continuum Flux Density per Beam|0.17400 | [y |
0.0
0.00000 | |y L‘
0.00000 | |kmis || |
0.0

Line Polarization Percentage

pattern using this button.

Overview

BRI ANTS

kcentered on the field center

You can turn “on/off”’ the mosaic beam

N

Coords Type (_) ABSOLUTE ® RELATIVH

Spstem ’JZOUU

Offset(Longitude)0.00000 |

| 00—

arcsec |3
1

]

»

Each circle is the size of the primary beam,

)




New: Put a mosaic around more than one field source .

Editors

‘ Spatial Field Setup ‘

System [J2000 | w [ SSes=smel Parallax [0.00000 [Tmas
L | display? v . -

So A ‘ 'mas;‘g
//Setting up the mosaic in the Field Setup \\F’?S”
S pe |RE
T Define the length, width and position angle
1 of the region to mosaic. Default is to
separate the field centers by about 48% of

the primary beam (the Nyquist rate).

Line Width ' 0.00000 | |kmis |+
Line Polarization Pergentage >0.0 '%
@ @ 1x 469, 175 13357.0 v '
&, [8] & [ x| 175 57. T —
[ 10:27:35.522, -43:56:25.99 (J2000)
Image Filename remijan\.jsky3\cache\jsky9043341093951517820 fits Coords Type ) ABSOLUTE ® RELATIVE
FOV Parameters pystem J2000 h 4
[2] =] Field Center ) .
Representative Frequency (Sky) 231.546 GHz Coordinates pfiset(Longitude)0.00000 EStlmated
Antenna Diameter ® 12m ) 7m &ﬂset(Latitude) [0.00000 number Of 7m
Antenna Beamsize (HPBW) 26.706 arcsec Array
Show Antenna Beamsize [v] | farcmin . .
| ~ pointings

Image Query

q length v2.0 | |arcmin | ¥

Image Server Digitized Sky (Version |

Image Size(arcmin) '10A0 | NO more than
| 150 12m Array
pointings.

Position AngIeVO.OOOOO

4@ of main beam 4 Reset to Nyquist

Export




L B = . -

A __A

File Edit View Tool Search Help

I Perspective 1

Proposal [ Program |

Spectral | Spatial |”Spectral Setup |

Unsubmilted Proposal

¢ & Project
¢ @@ Proposal
¢ [C3 Planned Observing
? . ScienceGoal (Copy of B6 12C0 (2-1),

[ ceneral
[ Field setup
[7) spectral Setup
[Ty calibration Setup
D Control and Performance
[Ty Technical Justification

< i |

D

ange :[-0.03125 GHz, 231.538 GHz]
[21[3
rFreq - : . Spec|Representatiy
(Rest) (Sky) Transition Bandwidth, Resolution (smoothed) Avg. Window
1(Full) |230.53800 GHz/230.53800 GHz/CO v=0 2-1 1875.000 MHz( 2438 km/s), 976.563 kHz( 1.270 km/s) 1 .

Select Lines to Observe in Baseband-1...

Basebg -
1(Fullf’| 0.00000 GHz

).00000 GHz |...Enter Name ...

Select Lines to Observe in Baseband-2... I | Add || Delete I %

Base

|l —_—

Template library. Turn the keys on the JTree below &r...

¢ @@ Proposal

¢ [ Planned Observing
ScienceGoal (B3 spectral sweep CO
ScienceGoal (B7 continuum: COSMO|
ScienceGoal (B7 CO(9-8): Cosmic Ey
ScienceGoal (B9 continuum: Cosmic

?

TV

ScienceGoal (B3 spectral sweep: PK{ |

validation | Validation History | Log |

4 Il

| Description

ScienceGoal (B? continuum: GRB |T0‘

Contextual Help




File Edit View Tool

Search Help

BB <= o/ @ *

Proposal | Program |

aju ] [e[i5] o]

Spectral | Spatial | Spectral Setup |

Unsubmiited Proposal

I Perspective 1

¢ [& Project
¢ @@ Proposal
¢ [ Planned Obsening

Note that for bands 3, 4, 6, 7 and 8, itis not possible to put 3 basebands in one sideband and the fourth one in the other.

Each baseband is 2GHz wide and can be separately configured i.e. each spectral window can have a different bandwidth and resolutia |

alllf

Spectral Type

? . ScienceGoal (Copy of B6 12C0 (2-1): N¢

[ General

[ Field setup

[7) spectral Setup
[ calibration Setup
[ control and Performance
[y Technical Justification

® Spectral Line
) Single Continuum
) Spectral Scan

Polarization products desired ) XX

Spectral Setup Errors

Spectral Line

Baseband-1

i | [»

[

¢ @ Proposal
¢ [J Planned Observing

Template library. Turn the keys on the JTree below &r... [X]
(Y L= TEMpraE Morary. TUr uTe KeySs OrTUTe JTTEE UETY

?

ScienceGoal (B3 spectral sweep CO
ScienceGoal (B7 continuum: COSMO
ScienceGoal (B7 CO(9-8): Cosmic Ey
ScienceGoal (B9 continuum: Cosmic
ScienceGoal (B3 spectral sweep: PK!
ScienceGoal (B3 continuum: GRB To|
ScienceGoal (B6 continuum: GRB To!
ScienceGoal (B7 continuum: GRB To!

ScienceGoal (B3 continuum: GRB To
ScienceGoal (B6 12CO (2-1): NGC32
ScienceGoal (B6 13CO (2-1): NGC32
ScienceGoal (B6 spectral line: Massi
ScienceGoal (B9 spectral line: Massi
ScienceGoal (B3 continuum: Protost

L R O A A

ScienceGoal (B6 continuum: GRB Tof—

Fractiorf Center Freq Center Freq - A Rep
i (Rest) (Sky) Transition Bandwi /
1(Full) |230.53800 230.53800 CO v=02-1 5.000 MHz( 2438 km/s), 976.563 kHz( 1.270 km/s) [1 (®)

Il

| Select Lines to Observe in Baseband-1... I | Add H Delete |

Baseband-2

Select Lines to Observe in Baseband-2... Add

Delete %

l

Validation | Validation History | Log |

Description Suggestion

[4]




. . O B =]
RQT Select Spectral tines l__r
-~
Transition Filter ransitions matching your filter settings: B
|CO* double-click column header for primary sort, single-click subsequent columns for secondary sorting. Single clicks will reverse sort order of alread l
Include description Transition = Description Rest Frequency < | Sky FrequencyUpper-state Energy Lovas Intensity
COv=21-0 Carbon Monoxide 113.172 GHz 113.172 GHz (6134675 K 0.01
Frequency Filters COv=11-0 Carbon Monoxide 114.222 GHz 114.222 GHz |3089.154K 0.01 'I
ALMA Band COv=01-0 Carbon Monoxide 115.271 GHz 115.271 GHz [5.532K 60/0.01 |
- COv=2 21 Carbon Monoxide 226.34 GHz 226.34 GHz |6145538K 0.02
c 0 COv=12-1 Carbon Monoxide 228.439 GHz 228.439 GHz |3100.118K 0.62|0.03
eyt b O v=02-1 Carbon Monoxide 230.538 GHz 230.538 GHz6.596 K 70[0.02
- 3 4 ° 6 7 8 9 0.110.6¢
Sky Frequency (GHz) CO+ J=2-1, F=5/2-3/2 Carbon Monoxide lon 236.063 GHz 236.063 GHz 0.1]1.2
0_ COv=2 L 339.5 GHz 339.5 GHz 6161.831K 0.03
q [ T T TR T TR T O T | COv=1 342648 GHz 342648 GHz [3116.561 K 0.71/0.03
Wi 313 M 950 COv=0 345796 GHz 345796 GHz (33.192K 70(0.03
n : ax CO+ J= 353.741 GHz 353.741 GHz 0112
2 . CO+ J=3-Z F= 354,014 GHz 354.014 GHz 0.18(1.71
LRI e COv=24-3 Carbon Monoxide 452645 GHz __ |452.645 GHz [6183.555K 0.04
[] Hide unobservable lines COv=14-3 Carbon Monoxide 456.843 GHz 456.843 GHz |3138.486 K 0.04
Finering unobservable lines CO V=0 4'3 Carbon Monoxide 461041 GHZ 461041 GHZ 55317 K 60 004
COv=254 Carbon Monoxide 565.774 GHz 565.774 GHz |6210.707 K 0.06=
. COv=154 Carbon Monoxide N, [571.021 GHz 571.021 GHz |3165.891K 0.06
M =
aximum Upper-state Energy (K) COv=054 Carbon Monoxide > |576.268 GHz ___ |576.268 GHz |82.074K 0.06
: O C 678.88 GHz |6243.288K 0.07 “
o 685.176 GHz [3198.774K 0.07
8 =L - i e 691.473 GHz [116.159K 100/(0.07
i - C 79196 GHz [6281.296 K 0.0
Molecule Filter / Environment COVETTA : 799.306 GHz [3237.134K 0.08
Show |al| atoms and molecules l vl COv=07-6 Carbon Monox!de 806.652 GHz 806.652 GHz |154.872K 110/0.08
COv=283-7 Carhon Manaoxide 905 009 GHz 905 009 GHz (6324 729 K 00¢
Add to Selected Transitions
Cantfind the transition you're looking for PP
in the offline pool? Find more in the Selected transitions
online Splatalogue.
Transition & Description Rest Frequency < Sky Frel
| Find More... CO v=02-1 230.538 GHz 230.538 GHz
| Reset Filters Remove from Selected Transitions '

Il
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File Edit View Tool Search Help Perspective 1
(a]n] [¢]w] [c]a] @« « &@ (@ =]
g
Proposal | Program | | spectral | Spatial | Specral Setup |
Unsubmiited Proposal |l Each baseband is 2GHz wide and can be separately configured i.e. each spectral window can have a different bandwidth and resolution. =l
o = Project Note that for bands 3, 4, 6, 7 and 8, itis not possible to put 3 basebands in one sideband and the fourth one in the other. -
¢ @@ Proposal
¢ [CJ Planned Obsening Spectral Type alt
¢ Bl scienceGoal (Copy of B 12CO (2-1): N
[ General ® Spectral Line 3
D Field Setup Spectral Type ) Single Continuum
[7) spectral Setup ) Spectral Scan
[y calibration Setup
[} Control and Performance Polarization products desired C) XX @ DUAL ) FULL —
[ Technical Justification Spectral Setup Errors
Spectral Line
213
Baseband-1
Fraction Center Freq Center Freq o . . Spec|Representativ
(Rest) (Sky) i Window
1(Full 1875.000 MHz( 2438 lm/3). 976.563 kHz( 1.270 km/ w1
117.188 MHz( 152 km/s), 61.035 kHz( 0.079 km/s)
234.375 MHz( 305 km/s), 122.070 kHz( 0.159 km/s)
a T I I | Select Lines to Observe in Baseband-1... | | s R e s ]
— Z 937.500 MHz( 1219 km/s), 488.281 kHz( 0.635 km/s)
Template library. Turn the keys on the JTree below &r... [X] ||| -Baseband-2 1875.000 MHz( 2438 km/s), 976.563 kHz( 1.270 km/s)
- N 2000.000 MHz( 2438 km/s), 31.250 MHz(40.638 km/s)
¢ @@ Proposal
¢ [J Planned Obsening
o ScienceGoal (B3 spectral sweep CO
o= ScienceGoal (B7 continuum: COSMO|
o= ScienceGoal (B7 CO(9-8): Cosmic Ey
o= ScienceGoal (B9 continuum: Cosmic
o= ScienceGoal (B3 spectral sweep: PK{ |
= | | Description | Suggestion |
() 3

Contextual Help _ Phasel:ScienceProposal



Correlator Versatility in Cycle 3 AL M A

~ 2GHz =

Cycle 1
Limit to 1 SPW
per baseband
on previous
cycles

baseband

[ ] TDM-128¢h
[ ] FDM- 3840 ch




Correlator Versatility in Cycle 3 AL M A

~ 2GHz =

Cycle 1
Limit to 1 SPW
per baseband
on previous
cycles

Cycle 2

and

onwards

Splitinto 4 or less
M SPWS per baseband

baseband

[ ] TDM-128¢h

[ ] FDM- 3840 ch




File Edit View Tool Search Help Perspective 1

[8]n] [¢]m)|c]a) @ * = 8o (W (@]

( Spectral | Spatial | Spectral Setup |

In the table below, itis possible to define up to 16 spectral windows, 4 per baseband as long as the total Fraction per baseband is no more than 1.
Each baseband is 2GHz wide and can be separately configured i.e. each spectral window can have a different bandwidth and resolution.
Note that for bands 3, 4, 6, 7 and 8, itis not possible to put 3 basebands in one sideband and the fourth one in the other.

¢ [ Planned Observing

? ' ScienceGoal (Copy Spectral Type
[Ty General

[ Field setup ® Spectral Line
[} spectral Setup © Singl

[ calibration Setu O spe

[y control and Perf
[Ty Technical Justifi ired ) XX

Sp
Spe

2l[=]

Baseband,

Fractiof / Center Freq Center Freq
(Rest) (Sky)

1/4 230.30000 GHz|228.16341 GHz... Enter Name ...| 117.188 MHz( 154 km/s), 244.141 kHz( 0.321 km/s) [
—— 1/4 231.10000 GHz|228.95599 GHz|... Enter Name ...| 117.188 MHz({ 153 km/s), 244.141 kHz( 0.320 km/s) =]

Template library. Turn the keys on... E’ : 1/2 230.53800 GHz/228.39920 CO v=02-1 375 MHz{ 308 kmi/s), 484.619 kHz( 0.636 kmi/s) Ol
Y TEMpPIaE mordary. Tanm ure |

-~

¢ @@ Proposal
¢ [ Planned Observing | Select Lines to Observe in Baseband-1... | | Add | Delete

ScienceGoal (B3
ScienceGoal (B7_
ScienceGoal (87 ||| “validation | Validation History | Log |
ScienceGoal (B9
ScienceGoal (B3
ScienceGoal (B3 -
ScienceGoal (B6 Must select a minimum of 1 science keywords imum 1 keywords)
ScienceGoal (B7| | Largest scale is not achievable with the 12m array configur
ScienceGoal (B6 Spectral Window name is invalid

Spectral Window name is invalid

Contextual Help

Spec|Representativ,

Transition Bandwidth, Resolution (smoothed) Window

< I | [»

?

15 errors, 0 warnings

Description

LR A R ¢

NRAO
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File Edit View Tool Search Help
|8|n] [¢]m| o) @ *

Proposal [ Program |
Unsubmiltted Proposal

pective 1

SCICIEEENE

Spectral Spectral Setup

¢ & Project
¢ @@ Proposal
¢ [C3 Planned Observing
? . ScienceGoal (Copy of B6 12CO (2-1): N

[ ceneral
[ Field setup
[7) spectral Setup
[Ty calibration Setup
D Control and Performance
[Ty Technical Justification

< i |

i —

Template library. Turn the keys on the JTree below &r...

¢ @@ Proposal

¢ [ Planned Observing
ScienceGoal (B3 spectral sweep CO
ScienceGoal (B7 continuum: COSMO|
ScienceGoal (B7 CO(9-8): Cosmic Ey
ScienceGoal (B9 continuum: Cosmic

?

TP

| »

In the table below, itis possible to define up to 16 spectral windows, than
Each baseband is 2GHz wide and can be separately configured i.e.
Note that for bands 3, 4, 6, 7 and 8, itis not possible to put 3 baseba

Left/right click to zoom infout, grab sliding bar to pan
Note: Moving LO1 here is for experimentation only - actual setup determigled by the win S

Obs d Frequency

A | 240/00 | 250100 |

R

190|IJIJ

o

Drag the green slider to
slide the VIEW

200'00

ag t ellow
move the first LO

Ical 10

i 1CIick in the yellow area to
"MAGNIFY

190/00 200(00 " 24000 250(00

Rest Freauency

Overlays: Receiver Bands [v] Transmission [ Overlay Lines [v] DSB Image | Select Lines to Overlay |

Water Vapour Column Density: @ Automatic Choice ) Manual Choice |1.262mm (4th Octile) | |

Viewport: | Panto Line I Zoom to Band | Reset I

ScienceGoal (B3 spectral sweep: PK{ |

validation | Validation History | Log |

4 [

ScienceGoal (B3 continuum: GRB |T0

| Description |

| Contextual Help _ PhasekScienceProposal

—T



Full Continuum & Polarization e

e OO0 ALMA Observing Tool (2014.6) - Proposal test of OT T)
File Edit View Tool Search Help ’ Perspective 1
[n]n]a]B] [<]= E]
Project Structure : Editors
("Proposal | Program | ~|(spectral ["Spatial | Spectral Setup |
¢ & Proposal test of OT T) | spectral Type — sl
¢ @@ Proposal i - - |
¢ [ Planned Observing 2 ) Spectral Line Full Polarization for
¢ {84 ScienceGoal (Science Goal) ||| - Spectral Type @ Single Continuum
[ General - Spegctral can NBandJ 3,6 and d7
[ Field Setup - ew: User can edit
[) Spectral Setup : ™ products desired C) XX ® DUAL () L frequencies used for
%Ca"br I full polarization
Cont
OHrea{ Standard single =
continuum setu ps, Receiver Band ;T;:?)?.;);Zi)o.coHcrzl v
.0-116. z
ifi i 4 (125.0-163.0 GHz]
can be modified with | [0 e0on
H 1F1 H 7 [275.0-373.0 GHz] .
justification st o e New: Band 10!
j 9 [602.0-720.0 GHz]
Rest Frequency |10 [787.0-950.0 GHz]
: —= ' -Baseband-1
Template library. Turn the keys on the JTr... : Fractio| Center Fre Center Fre Spec|Representati
¢ (& Template library. Turn the keys on th = | : (Rest) q (Sky) q Transition Bandwidth, Resolution (smoothed) :vg. pWindow
o Ll et ) || |1(Ful) |866.25000 G...|866.25000 G...|single Continu...|1875.000 MHz( 649 km/s), 31.250 MHz(10.815 km/s) e
¢ [J Planned Observing :
o- [&28 ScienceGoal (B3 spectral sy q 2
= ScienceGoal (B7 continuum
: Sc?enceGoa: (B7 CO(E?-S): ( | Baseband-2
scienceGoal (B9 continuum|=| | 3Fy[j) [§68.25000 G...[868.25000 G.../Single Continu...|1875.000 MHz( 647 km/s), 31.250 MHz(10.790 km/s) EC
(= ScienceGoal (B3 spectral sy %
o ScienceGoal (B3 continuum
o= ScienceGoal (B6 continuum
= Sc?enceGoaI (B7 continuum Tra T L
* jil| ScienceGoal (B6 continuum| ||| [7Eij [§70.25000 G...|870.25000 G...[Single Continu...|1875.000 MH2( 646 km/s), 31.250 MHz(10.765 km/s) e
= ScienceGoal (B3 continuum|™ ||
o ScienceGoal (B6 12CO (2-1
o ScienceGoal (B6 13CO (2-1 ||
o- [#4 ScienceGoal (B6 spectral |i:l 1| “Baseband-4
© jill ScienceGoal (B9 spectrallin | 13 (Fyll) [872.25000 G...[872.25000 G...Single Continu...[1875.000 MHz( 644 km/s), 31.250 MHz(10.741 km/s) e
(= ScienceGoal (B3 continuum ;
o ScienceGoal (B6 continuum = |
Eniameinnt it st | =




Automated spectral scan - |

RgT Project - Observing Tool for ALMA, version Cycle2Test2

File Edit View Tool Search Help |Perspective1
Bjo| [4]a|cla) @ * = oim B (@]c]] o]

Proposal [ Program |

Unsubmitted Proposal .
¢ B Project ) Spectral Line
¢ & Proposal Z
¢ [ Planned Observing
? H ScienceGoal (Copy
[y ceneral
[ Field Setup i
[y spectral Setup Spectral Setup Errors
[ calibration Setu| | || Spectral Scan
[y control and Perf
[Ty Technical Justifi

Spectral | Spatial | Spectral Setup |

2=

|»

Spectral Type ) Single Continuum
(® Spectral Scan

Polarization products desired ) XX ® DUAL ) FULL

Requested start frequency (sky) |9540 |GHz | v
Requested end frequency (sky) W
Requested range (rest) 95.8896 GHz - 108.0020 GHz
Achieved scan range (sky) 95.0 GHz- 110.0 GHz
< T I L Bandwidth, Resolution (Hanning smoothed)|1875.000 MHz, 976.563 kHz |v| 2
Template library. ‘I:;the keys on...[X] Spectral averaging |1 |v|

Y L= TEMpraE morary. TarnT e Kg
¢ @@ Proposal

¢ [ Planned Observing

o= ScienceGoal (B3

Representative frequency (sky) 102.50000

The representative frequency defined in the observed frame is used in conjunction with the sensitivity gAtered on

o- [8iN ScienceGoal (B7|= |- J . e : )

o ScienceGoal (B7 ::g the 'Cont.rol apd Pelfqrmance' page to est!mate the required observing time and t.o setthe size ofth n.tenna beam shown in

o ScienceGoal (B9 g the "Spatial Visual’ editor. The representative fregugncy defaglts to the average mid-frequency of th# achieved scan range but may be
— subsequently set by the user to any frequency within the achieved scan range.

o= ScienceGoal (B3

o= ScienceGoal (B3 Tuning (Max. 5) SPW 1 (GHz) SPW 2 (GHz)

o= ScienceGoal (B6 1 95.9375 GHz 97.8125 GHz

o ScienceGoal (B7| 2 99.6875 GHz 101.5625 GHz

o ScienceGoal (B6 3 103.4375 GHz 105.3125 GHz

'S ScienceGoal (B3 4 107.1875 GHz 109.0625 GHz

o=

ScienceGoal (Bf| |
[ »




Automated spectral scan - |l

RgT Project - Observing Tool for ALMA, version Cycle2Test2

(=@

NN

File Edit View Tool Search Help

CIEIRENE

Perspective 1

Project Structure

Jl Proposal | Frooram |

Unsubmiited Proposal
? E"r Project
¢ B Proposal
¢ [ Planned Observing
? ﬂ ScienceGoal (Copy
D General
[y Field setup
[} spectral Setup
[T calibration Setu

[Ty Technical Justifi

< Il | [»

Y L= TEMPIdE mordry. TAnTue e
¢ @@ Proposal =
¢ [ Planned Observing

o= ScienceGoal (B3
ScienceGoal (B7|=
ScienceGoal (B7|
ScienceGoal (B9| |
ScienceGoal (B3
ScienceGoal (B3
ScienceGoal (B6
ScienceGoal (B7|
ScienceGoal (B6
ScienceGoal (B3
ScienceGoal (B6

TYYTPTYTYTRYY

[ Control and Perf |

Template library. Turn the keys on... E]

| Editors

coverage
\ g

“|("spectral | Spafial | Spectral Setup |
2| visualisation

ﬁv;;ual Representation
of the Spectral Scan
Mode — Actual spectral

coverage vs. requested

put 3 basebands in one sideband and the fourth one in the other.

ual setup determined by the windows

Observed Frequency

ctral windows, 4 per baseband as long as the total Fraction per baseband is no more than 1.
onfigured i.e. each spectral window can have a different bandwidth and resolution.

[»

2]

\K P

VASS LSS VIS SIS ST
A 7A

VAL LSS VIS LSS ST

Tasloo T " T Togoo™ T T Tosfop! & T R T

Rest Frequency

Overlays: Receiver Bands

Transmission [_] Overlay Lines DSB Image ‘ Select Lines to Overlay ‘

Spectral Scan: Requested Scan Tuning 1 Tuning 2 Tuning 3 Tuning 4

Water Vapour Column Density: @ Automatic Choice ) Manual Choice ’1.262mm (4th Octile) ‘ ‘

Viewport: Panto Line Zoom to Band I Reset |

Spectral Type

() Spectral Line

) Single Continuum

Spectral Type

=]

4




® O O ALMA Observing Tool (2014.6) - Observing Tool for ALMA Cycle3 Groundhog Day Test

File Edit View Tool Search Help / | parcngctive 1

[n]n]a]a] |<[a [c]a] EILE] Control and Performance defines the
 proposal [ o Pepect ool i reromane D | Fequired angular resolution, sensitivity,

 Proposal I Program I z|[ Spectral

W

lj 9 @ Observing Tool for ALMA Cycle3 Grou #|| These parameters are used to control various aspects g Iargest angulal" Scale, etc- B

¢ @ Proposal Control and Performance j
¢ [J Planned Observing ;
? E ScienceGoal (Science Goal) 2 Configuration Information
[ General “|| Antenna Beamsize (1.13 *A /D) 12m [17.276 arcsec | 7m [29.615 arcsec |
[} Field setup :
[ spectral Setu “| Number of Antennas 12m [36 | 7m [10 | TP |2

Most compact 12m configuration Most extended 12m configuration
max) [0.185 km | [5.499 km |

| (Control and Performance
A

Longest baseline (L

Synthesized beamsize (A/Lp,,,) [0.994 arcsec | [0.033 arcsec |
Shortest baseline (L) [0.015 km | [0.212 km |
Maximum recoverable scale (0.6A/L;;) [8.123 arcsec | [0.541 arcsec |
~
Desired Performance - - =
<] M ] D Desired Angular Resolution 0.00000 Array propertles summarlzed
= New: Varies with declination
Template library. Turn the keys on the )... #|l Largest Angular Structure in source Undefined Y
¢ (= Template library. Turn the keys on|=| |
¢ & Proposal #|| Desired sensitivity per pointing 0.00000 equivalent to Infinity EE
¢ [J Planned Observing :
o B scienceGoal (B3 spectral || Bandwidth used for Sensitivity IRepresentativeWindowResolution lvl Frequency Width| 0.122070 MHz |
o ScienceGoal (B7 continuu
o= ScienceGoal (B7 CO(9-8) “)l' Do you request complementary ACA Observations? ) Yes ® No
o &2l ScienceGoal (B9 continuul | |
= ScienceGoal (B3 spectral || Science goal integration time estimate
o [&28 ScienceGoal (B3 continuy | |-
T Sc!encecoal (86 contfnuu Override OT's sensitivity-based time estimate (must be justified) ) Yes @ No
o ScienceGoal (B7 continuu
o ScienceGoal (B6 continuu ) ) ] —~ = -
. A = Are the observations time-constrained? ) Yes ® No 1
= ScienceGoal (B3 continuu : -
o- [} ScienceGoal (B6 13CO (2| || |Feedback
o- [8 ScienceGoal (B6 spectral| || || Validation | Validation History | Log |
o- &4 ScienceGoal (B9 spectral| | |-
o= ScienceGoal (B3 continuu | Description Suggestion
o ScienceGoal (B6 continuu: 7

<] i [ [»]
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ALMA Observing Tool (2014.6) - Observing Tool for ALMA Cycle3 Groundhog Day Test

File Edit View Tool Search Help

(nnjaja] [¢]=] =]

[ parcneactive 1

C
(-
ST

§ ScienceGoal (B6 spectral
 ScienceGoal (B9 spectral
§ ScienceGoal (B3 continuu:
§ ScienceGoal (B6 continuu:

o] |

/
Control and Performance defines the

[ Validation | Validation History | Log |

| Description Suggestion

Project Structure : Editors - . agn
lj Proposal | Program | | Spectral | spat€_{ Control and Performance 3 required angular resolution, sensitivity,
% [ Observing Tool for ALMA Cycle3 Grouf]| These parameters are used to control various aspects g |al'ge$t angu|al' Scale, etc. ]
¢ @ Proposal Control and Performance K . j
¢ [J Planned Observing 2]
? E ScienceGoal (Science Goal) Configuration Information
[ General Antenna Beamsize (1.13 *A /D) 12m [17.276 arcsec | 7m [29.615 arcsec |
[ Field Setup
D Spectral Setup Number of Antennas 12m |36 | 7m \10 | TP [2
‘ v 1 d U yelup
| |Control and Performanc Longest baseline (L..)
’ max A A
TS| V _ Specify the desired angular
Synthesized beamsize (A/L..) .
, resolution and the largest
Shortest baseline (L)
Maximum recoverable scale (0.6)\/Lm StrUCtu re In the map area
Desired Performance S
<] M ] D Desired Angular Resolution
Template library. Turn the keys on the J... Largest Angular Structure in source '@E— New- Use 0 for. a true p°|nt
¢ G5 Template library. Turn the keys on|~ source. There is no default!
¢ & Proposal Desired sensitivity per pointing 0.00000 equivale
¢ [J Planned Observing |
o B scienceGoal (B3 spectral Bandwidth used for Sensitivity ’RepresentativeWindowResolution ‘v‘ Frequency Width[ 0.122070 MHz |
o- [&e8 ScienceGoal (B7 continuu
o- [528 ScienceGoal (B7 CO(9-8) Do you request complementary ACA Observations? ) Yes ® No
o- [se8l ScienceGoal (B9 continuu| =
o- 1544 ScienceGoal (B3 spectral Science goal integration time estimate
o- t&24 ScienceGoal (B3 continuu
” Sc!enceGoal (86 cont!nuu Override OT's sensitivity-based time estimate (must be justified) ) Yes @ No
o- (524 ScienceGoal (B7 continuu
o- (824 ScienceGoal (B6 continuu ) ) ) . . L
e N Are the observations time-constrained? ) Yes ® No —
o ScienceGoal (B3 continuu -
o- [&28 ScienceGoal (B6 12CO (2 e
o- [&8 ScienceGoal (B6 13CO (2 Feedback
o=
o=
o=
o=




Think about your target...

S
\—\

ALMA

- Observed with different ALMA configurations

) ;j “Compact” i

20 2
< 15 5
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0/aala) [<[s) [o]u

ALMA Observing Tool (2014.6) - Observing Tool for ALMA Cycle3 Groundhog Day Test

CIEIRENE

Project Structure

("Proposal | Program |

A

‘|Editors

Control and Performance

¢ [& Observing Tool for ALMA Cycle3 Grou
¢ & Proposal
? ﬂ Planned Observing

2) ScienceGoal (Science Goal)
D General

[ Field Setup

D Spectral Setup

| i |

Template library. Turn the keys on the J...
9 [= Template library. Turn the keys on
¢ & Proposal
? ﬁ Planned Observing
ScienceGoal (B3 spectral
4 ScienceGoal (B7 continuu
ScienceGoal (B7 CO(9-8)
ScienceGoal (B9 continuu
ScienceGoal (B3 spectral
ScienceGoal (B3 continuu
ScienceGoal (B6 continuu
ScienceGoal (B7 continuu
¥ ScienceGoal (B6 continuu
ScienceGoal (B3 continuul |
4 ScienceGoal (B6 12CO (2
ScienceGoal (B6 13CO (2
ScienceGoal (B6 spectral
ScienceGoal (B9 spectral
ScienceGoal (B3 continuu
ScienceGoal (B6 continuu

o - p

?

[

LA O A A A A 4

Lin

e

These parameters are used to control various aspects g

Control and Performance

Configuration Information

Control and Performance defines the
required angular resolution, sensitivity,
largest angular scale, etc.

Antenna Beamsize ( 1.13 *A /D)

12m [17.276 arcsec

| 7m [29.615 arcsec |

Number of Antennas 12m [36

| —n [

| 7m [10

Most compact 12m configuration Most extended 12m configurati

Some comblnatlons

Longest baseline (L,,.) [0.185 km

| [5.499 km |

of angular scale and

Synthesized beamsize (A/L,,,) [0.994 arcsec

| [0.033 arcsec

resolution require

Shortest baseline (L) [0.015 km

| [0.212 km

Maximum recoverable scale (0.6A/L;) [3_123 arcsec

the compact array.

| [0.541 arcs

Desired Performance

Desired Angular Resolution
Largest Angular Structure in source
Desired sensitivity per pointing
Bandwidth used for Sensitivity

Do you request complementary ACA Observations?

Science goal integration tin 800

0.00000 equivalent to 0.0000

|RepresentativeWindowResqution | v | Freque

The “Suggest”
button will tell
you when

) Yes ® No

ACA Necessity Estimator

Override OT's sensitivity=

Are the observations tim

|[ Validation

ACA use is recommended
The ALMA Observing Tool suggests this observation needs the ACA because

the desired largest scale 12.0(arcsec] is large enough relative to the main array recoverable scale.

[

I OK H Cancel l """"

| Description Suggestion
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ALMA Observing Tool (2014.6) - Observing Tool for ALMA Cycle3 Groundhog Day Test

File Edit View Tool Search Help

G
(- :
ST

[ parcneactive 1

/

Control and Performance defines the

Project Structure : Editors : - . agn
f Proposal | Program | (‘Spec ) (ComEm e required angular resolution, sensitivity,
9 (& Observing Tool for ALMA Cycle3 Grou These parameters are used to control various aspects d |al'ge$t angu|al' Scale, etc. el
¢ @ Proposal Control and Performance j
¢ [J Planned Observing 2]
? E ScienceGoal (Science Goal) Configuration Information
[ General Antenna Beamsize (1.13 *A /D) 12m [17.276 arcsec | 7m [29.615 arcsec |
[} Field setup
D Spectral Setup Number of Antennas 12m |36 | 7m |10 | TP [2
[ . 0 up Most compact 12m configuration Most extended 12m configuration
|} Control and Performance Longest baseline (L,,,,) [0.185 km | [5.499 km |
A ;
Synthesized beamsize (A/Lp,,,) [0.994 arcsec | [0.033 arcsec |
Shortest baseline (L) [0.015 km | [0.212 km |
Maximum recoverable scale (0.6A/L;;) [8.123 arcsec | [0.541 arcsec |
Desired Performance S
<] M ] D Desired Angular Resolution W ’arcsec 'v‘
Template library. Turn the keys on the J... Largest Angular Structure in source Undefined
¢ (= Template library. Turn the keys on |+ |
¢ & Proposal Desired sensitivity per pointing = equivalent to Infinity EE
¢ [J Planned Observing
o B scienceGoal (B3 spectral Bandwidth used for Sensitivity RepresentativeWindowResolution 1v‘ Frequency Wldth[ 0.122070 MHz
o- [&e8 ScienceGoal (B7 continuu
o- [528 ScienceGoal (B7 CO(9-8) Do you request comple \ D b
o- [se8l ScienceGoal (B9 continuu| = . . . r I ve n y
o- [s58 ScienceGoal (B3 spectral Science goal integratio specrfy deS|red noise Ievel (Jyl B Esti
o- t&24 ScienceGoal (B3 continuu .
o [ sciencecoal @s coninws | | ... | ppeam) and the bandwidth over your
o- [&28 ScienceGoal (B7 continuu .
o [ scienceGoal @6 contmad || | which that should be measured - I B
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o- [524 ScienceGoal (B6 13CO (2 Feedback
o [¥ ScienceGoal (B6 spectral [ Validation | Validation History | Log |
o- [ ScienceGoal (B9 spectral
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o- [sell ScienceGoal (B6 continuu:
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The sensitivity calculator is available separately in the OT (or on the web)

ol for ALMA, version CycleZTest2 W A Sm——

A LO Configuration Tool..., @ @

i sensitivity Calculator...

v

¢ 3 Planned Observing
¢ il scienceGoal (Cop
[y General
[ Field setup
[) spectral Setup| | -
[ calibration Sej /

! [ control and P
[ Technical Just

|

|

: <] i | [»

Template library. Turn the keys o...

¢ @@ Proposal
¢ [ Planned Obsenving

?

TYY?PPYY

—

| Perspective 1

Spectral i Spg Control and Performance |

N@ Sensitivity Calculator

Configuration Information

Antenna Beamsize (1.2*A/D

Number of Antennas

Longest baseline (Lmax)
Synthesized beamsize (NLmax‘

Shortest baseline (Lmin)

Maximum recoverable scale (0|

Desired Performance

Desired Angular Resolution

Largest Angular Structure in soy)|

Desired mosaic sensitivity

Bandwidth used for Sensitivity

Do you request complementary

Science goal integration time eg/|

Is more time required due to u

=

Are the observations time-consi

]

Contextnal Heln

= B 22
Common Parameters
Dec 00:00:00.000 |
Polarization Dual v
Obsenving Frequency 345.00000 GHz v
Bandwidth per Polarization (0.00000 GHz v
Water Vapour ® Automatic Choice ) Manual Choice
Column Density 0.913mm (3rd Octile)
taulTsky tau=0.158, Tsky=44.400 K
Tsys 153577 K
Individual Parameters
12m Array 7m Array Total Power Array
Number of Antennas |34 | o | 2 |
Resolution 0.00000 arcsec w | 5974554 arcsec 17.923662 arcsec
Sensitivity(rms) 0.00000 Jy v |0.00000 |Jy v |0.00000 |Jy v
(equivalent to) Infinity K w | 0.00000 K |w/| 0.00000 K |»w
Integration Time ~(0.00000 s ~ | 0.00000 |s | +|0.00000 s |w
Integration Time Unit Option |Automatic | N I

I Calculate Integration Time I

| Calculate Sensitiity |

| Close I

-

Il

<]




] ]
[Iime estimates - |
| L Observing Tool (2014.6) - Observing Tool for ALMA Cycle3 Groundhog Day Test

| File Edit View Tool Search Help

[ajujaja) ¢

[P P =Y e PN == [mllhalaal [al
8 .00

Estimated Time

Perspective 1

Project Structure
 Proposal | Program

¢ (= Observing Tool fol
¢ & Proposal

< Il

Template library. Turn t
¢ (= Template library
¢ (& Proposal

¢ [ Planned
Scie
Scie
Scie
Scie
Scie
Scie
Scie
Scie
Scie
Scie
Scie
Scie
Scie
Scie
Scie
Scie

?

LA A A A A O O ¢

-

®

Note: The time in brackets is that required to reach the sensitivity.
Operational requirements often mean that the actual observed time is longer,
especially for mosaics. Please see the User Manual for more details.

Input Parameters

Requested sensitivity 10.00 mjy
Bandwidth used for sensitivity 0.122 MHz
Representative frequency (sky, first source) 337.06 GHz

Precipitable water vapour (all sources)

Total number of pointings (all source
Number of tunings

Total time on source
Calibration time

Other overheads

Total time for 1 SB execution
Number of SB executions
Total time to complete SB 1.17 h

27.98 min

Calibration Breakdown per SB execution

1.68 min

1 x SidebandRatio

1 x Amplitude 2.60 min
2 x Bandpass 15.20 min
4 x Phase 2.40 min

0 min
min

2 x Phase reference check source
6 x Atmospheric

Additional Arrays

Time required for additional 12- 35.13 min
ACA 7-m time (t_12m x 2) 2.34h
Total ACA time (max([t_7-m,t_TP]) 2.34 h

Estimated total time for science goal 4.10 h

rvations, including the required antenna configurations and integration times.

| 7m [29.615 arcsec |

0.658mm (2nd Octile)

| 7m [10 | TP |2

uration Most extended 12m configuration
[5.499 km |

[0.033 arcsec |

22.17 min [22.08 min]

0.212 km |

[0.541 arcsec |

( N
0.12000 |arcsec |v| :ou can shee
ow mucC
12.00000 -arcsec .
> time you need

.01 by || equivalentto 7.47375

and get a
RepreWndowResolution |v| Frequency Wid

\breakdown

) Yes ® No
) Yes~# No

[»

~ New: Total power will not be scheduled
when 12m+7m synthesis suffice

| Suggestion




Time estimates - Il

RgT Project - Observing Tool for ALMA, version Cycle2Test2

S

==

File Edit View Tool Search Help

4 ALMA OT - Information

s

@

Estimated time

Requested sensitivity

Bandwidth used for sensitivity
Representative frequency (sky, first source)
Precipitable water vapour (all sources)

ALMA 12m Array - 34 antennas

Time on source per pointing (first source)
Total number of pointings (all sources)
Estimated number of tunings required
Total time on source

Total time on calibrators

Total overheads

2.4640 mJy
0.977 MHz

102.50 GHz
5.186mm (7th Octile)

4.83 min
23

4

741h
446 h
105.60 min

Total 12m array time (inc. calibration & overheads) 13.63 h

Calibration Breakdown

16 x SidebandRatio

12 x Pointing

16 x Amplitude (inc. AtmosphericCal)
16 x Bandpass (inc. AtmosphericCal)
48 x Phase (inc. AtmosphericCal)

48 x Atmospheric

Additional calibration overheads

Additional 12M Array Configurations

No of 12M Array Configurations
Additional overhead for extra configurations

Estimated total time for science goal

26.93 min
3.60 min
52.27 min
154h
1.01h
32.00 min
145h

6.82h

2045 h

| Perspective 1

aspects of the observations, including the required

60.328 arcsec
34 im 9

Most compact 12m
0.166 km

extended 12m configuration

7m 103.420 3|

antenna configurations and integration times.

/~ Multiple array
configuration time
estimates based on

resolution and largest

3.642 arcsec

0.014 km

25.511 arcsec

022674 : equivalentto 0.00246

_ angular scale.

J

n
n[~]
FEM

|FinestResolution

| v | Frequency width 0.976563 MHz

lions? ) Yes @ No

es? (must be justified) ) Yes @ No

£ Ve (@ Nla

Suggest

Time Estimate




Time constrained observing

-
RgT Project - Observing Tool for ALMA, version Cycle2Test2 .
File Edit View Tool Search Help I Perspective 1

DO N[ SN NEIRENE

:|[ Spectral | spatial [ Control and Performance |

Proposal I’Program |

ScienceGoal (B3

Unsubmitted Proposal Do you request complementary ACA Observations? JYes ® No Suggest | - |
¢ & Project
¢ B Proposal Science goal integration time estimate
¢ [ Planned Observing
? ‘ EF' Zn;ej:fl (Copy Is more time required due to u,v coverage issues? (must be justified) ) Yes @ No
[ Field Setup o ) . . L
Are the observations time-constrained? ® Yes ) No @ Specific Dates ) Multiple Epochs (' Continuous Monitoring
D Spectral Setup
[ calibration Setu Number of time windo pecuﬁed 1 / /
[) Control and Perf | Start DajTime (UTC) End parﬂrime (UTC)
D Technical Justifi| | = . . _ . m”/ 13 2013_1 T8
Please specify one or more suitable time windows
for your observation
Your
0)
< Il | [»
| | — ]
Template library. Turn th'e keys on... E Add I | Delet
¢ @& Proposal
¢ [ Planned Observing =
o- 58l ScienceGoal (B3 34567829
(= ScienceGoal (B7|
(= ScienceGoal (B7|
o= ScienceGoal (B9
o ScienceGoal (B3 /
o= ScienceGoal (B3
o ScienceGoal (B6 | |
o= ScienceGoal (B7|
(= ScienceGoal (B6
o=
o=

q i [

Contextual Help .~ Phasel:ScienceProposal




« What else new in Cycle 3 OT? "™

u||U||H|||=||"||'\||B||LaJ| bl |\ = | | MR Y
Project Structure Tean

Proposal | Program |

[ Spectral | Spatial | ScienceGoal (Science Goal) |

I

SExagesa Parallax [0.00000 mas
System J2000 |~ display? [7] I |
Source Coordinates RA 27:02:43.2912 PMRA [0.00000 mas/yr ||

Dec  [-42:16:39.978 PM DEC [0.00000 mas/yr || a
Source Radial Velocity |0.000 km/s |+ | hel |w| z|0.000000000 | Doppler Type RELATNISTIC

Target Type ® Individual Pointing(s) © 1 Rectangular Field

Observing Tool for ALMA Cycle3 Grou,

? & Proposal

¢ [] Planned Observing

? “ ScienceGoal (Science Goal)

[ General
[ Field setup
[7) spectral Setup
[ calibration Setup
[ control and Performanc
[T} Technical justification

Expected Source Properties

Peak Continuum Flux Density per Bea

0.00000

[0.0 3
0.00000
0.00000

Continuum Polarization Percentage

Peak Line Flux Density per Bea

Line Width

Line Polarization Perce I0.0 [9%
Field Center Coordinates

< i | [ »
Template library. Turn the keys on the J... |Z

¢ [& Template library. Turn the keys on |4 set

¢ & Proposal |arcsec |v|
¢ [J Planned Observing N
o ScienceGoal (B3 spectral
ScienceGoal (B7 continuu A [arcsec] Dec [arcsec]

ScienceGoal (B7 CO(9-8)
ScienceGoal (B9 continuu
ScienceGoal (B3 spectral
ScienceGoal (B3 continuu
ScienceGoal (B6 continuu
ScienceGoal (B7 continuu
ScienceGoal (B6 continuu

LA A A O A O A ¢

scienceGoal (83 continuu— | ][ Validatk()?/r Validation History | Log |
ScienceGoal (B6 12CO (2 9 errors, (fwarnings
ScienceGoal (B6 13CO (2 Description Suggestion
ScienceGoal (B6 spectral [x] Nofrincipal Investigator specified Select the top level Project node in the tree and fill in the Principal Investigator field -
ScienceGoal (B9 spectral @ [Nd/ scientific category defined Select Proposal node and set a scientific category
ScienceGoal (B3 continuu @ (Mo document fqupd - you mus't add a Science Case to your proposal (Select the proposal node in the Proposal tab anq add your documgqt =
@ _Must select a minimum of 1 science keywords Select the Proposal node and then add some science keywords (minimum 1
ECfence'G_oa! (EE contlnuu: @WExpected peak continuum flux is required for a single continuum Select the Target Parameters (anti-bllac) in the Science Goal and enter a valid value
< il | ]| @ |Either a continuum or a line polarization percentage is required for |Select the Target Parameters (anti-bllac) in the Science Goal and enter a valid value |+




n New cle 3 i

ALM Observing Toolem 6) - Observmg Tool for AM Cycle3 Groundhog

..JTech Justificatjo !

ay Test

Elle Edit View Tool Search Help |Perspectivel

[8[a[a[a] [<]a] =@

8] (@] =l [o]

Project Structure

oA

Editors

[ Technical Justification |

[\ Proposal [ Program |

¢ [& Observing Tool for ALMA Cycle3 Ground
¢ [ Proposal
¢ [ Planned Observing

¢ ScienceGoal (Science Goal)
[ General
[ Field Setup
[ spectral Setup
[ calibration Setup

[7) rechnical Justification

< Il | »

a

¢ (@ Template library. Turn the keys on th
9 & Proposal
? m Planned Observing
N ScienceGoal (B3 spectral sy
ScienceGoal (B7 continuum
ScienceGoal (B7 CO(9-8): (
ScienceGoal (B9 continuum
ScienceGoal (B3 spectral sy
ScienceGoal (B3 continuum
ScienceGoal (B6 continuum
ScienceGoal (B7 continuum
ScienceGoal (B6 continuum
ScienceGoal (B3 continuum
ScienceGoal (B6 12CO (2-1
ScienceGoal (B6 13CO (2-1
ScienceGoal (B6 spectral li
ScienceGoal (B9 spectral li
ScienceGoal (B3 continuum
ScienceGoal (B6 contmuum —

Lin

Template library. Turn the keys on the JTr...

[ Spectral I' Spatial

Enter a Technical Justification for this Science Goal, paying special attention to the parameters reproduced below.

 sensitivity

Requested RMS over 2.4414062500000005E-4 GHz is 3.00 m)y For a peak flux density of 30.00 m)y , the achieved S/N is 10.0

Achieved RMS over the total 351.56 MHz bandwidth is 111.80 u)y For a continuum flux density of 100.00 mJy , the achieved S/N is 894.4

For a peak line flux of 30.00 m)y , the achieved S/N over 1/3 of the source line width ( 30.00 km/s /3 = 10.00 km/s ) is 26.1

Line width / bandwidth used for sensitivity 30.00 km/s / 731.92 m/s = 40.99

Dynamic Range: 33.33

Justify your requested RMS and resulting S/N for the spectral line and /or continuum observations.

For line observations also justify the bandwidth used for the sensitivity calculation.

Here would be the standard required justification of
the sensitivity parameters

[»

\

-

There are separate sections for Sensitivity,
Imaging and Correlator setup

Imaging

Requested angular resolution : 1.10 arcsec

Requested largest angular scale : 1.00 arcsec

Each requires its own 50+ word
justification

ustify the chosen angular resolution and largest angular scale for the sour




Tech Justification New for Cycle 3

[a[a]a[a] [4]x] [=[a)

LIEIRENE

Perspective 1

Project Structure

[ Proposal f Program

WA

("Spectral I Spatial r Technical Justification I

Editors

? & Observing Tool for ALMA Cycle3 Ground|
¢ & Proposal
¢ [J Planned Observing
? ScienceGoal (Science Goal)

[ General
[ Field setup
D Spectral Setup
[ calibration Setup
[ control and Performance

| ) Technical Justification

< I | [»

Template library. Turn the keys on the JTr... [E
¢ (& Template library. Turn the keys on th = |
¢ (& Proposal
¢ [ Planned Observing

%28 ScienceGoal (B3 spectral sy
M ScienceGoal (B7 continuum
28 ScienceGoal (B7 CO(9-8): (
M ScienceGoal (B9 continuum| =
528 ScienceGoal (B3 spectral sy
28 ScienceGoal (B3 continuum
£y ScienceGoal (B6 continuum
ScienceGoal (B7 continuum
ScienceGoal (B6 continuum
ScienceGoal (B3 continuum| |
ScienceGoal (B6 12CO (2-
&Nl ScienceGoal (B6 13CO (2-
£ ScienceGoal (B6 spectral li
2l ScienceGoal (B9 spectral li
e ScienceGoal (B3 continuum
24 ScienceGoal (B6 continuum =

?

TP YY

c mml D

] Il | Dl

7 Imaging‘ )

i|| Requested angular resolution : 1.10 arcsec

|l Requested largest angular scale : 1.00 arcsec

ustify the chosen angular resolution and largest angular scale for the source(s) in this Science Goal

Here would be the standard required justification of
the imaging parameters

Il ACA is not recommended but is selected.

ustify over-riding of the OT recommendation for the ACA

Exceptions to standard practice require separate
justification. Here, the OT notes that the ACA is

selected even though the OT thinks it is unneeded.

Correlator configuration

|| line width / representative spectral window resolution: 30.00 km/s / 731.92 m/s = 40.99

Representative spectral window width : 702.64 km/s

Justify your correlator set-up with particular reference to the number of spectral resolution elements per line width.
You may want to consider spectral averaging to lower the data rate

| »

[

Here would be the regular required correlator justification




Project - Observing T =
Edit View Tool Search Help

ew Proposal Ctrl-N 2 B | [ li' @

New DDT Proposal Ctrl-D

Perspective 1

Open Project »
Save Ctrl-S
Save As...

("Spectral | Spatial | Project |
Principal Investigator

(2]

=i Show ALMA Template Library
Use Project as Template »

SelectPI...

V] validate S i

Submit Project

(2]

Preferences \
Quit L

Project Code None Assigned

Validation |  Validation History | Log |

Suggestion

Contextual
1. Please ensure vou and your co-Is are registered with the ALMA New
Science Portal Science
2. Create a new proposal by either: Proposal ‘ ‘
® Se.lec.tm g File > Ne,w Prf)po sal Click on the overview steps to view the contextual help
® Clicking on the & icon in the toolbar —_— -
@ Or clicking on this link

3. Click on the & proposal tree node and complete the relevant
fields.




Summary: New for Cycle 3 OT

For Cycle 3, there are a relatively small number of new "ALMA" features:

+ Band 10 (780 — 950 GHz)
+ Free choice of TDM frequency for full polarization observations (Bands 3, 6 and 7)
+ 36 12-m array, 10 7-m array, 2 TP

There are more new "OT" features:

+ Sesame is now used to query source information

+ A Science Goal can contain multiple sources with rectangular field definitions

+ The TP mapping area is automatically calculated for custom mosaics or single pointings
+ Import/export of pointing positions has been updated slightly

+ Absolute positions can be used for pointing centers

+ “Point source” button has been removed, use 0 for LAS, there is no default

+ TP will not be scheduled if 7-m array can achieve the requested LAS

+ Various improvements to time-constrained interface

+ Technical Justification node completely overhauled

+ Total time for a proposal can be displayed in the main OT GUI — Under “Tool” in menu bar

-~



For more info:

https://almascience.nrao.edu/

The Atacama Large Millimeter/submillimeter Array (ALMA), an international astronomy facility, is a
partnership of Europe, North America and East Asia in cooperation with the Republic of Chile.
ALMA is funded in Europe by the European Organization for Astronomical Research in the
Southern Hemisphere (ESO), in North America by the U.S. National Science Foundation (NSF) in
cooperation with the National Research Council of Canada (NRC) and the National Science Council
of Taiwan (NSC), and in East Asia by the National Institutes of Natural Sciences (NINS) of Japan in
cooperation with the Academia Sinica (AS) in Taiwan. ALMA construction and operations are led on
behalf of Europe by ESO, on behalf of North America by the National Radio Astronomy Observatory
(NRAO), which is managed by Associated Universities, Inc. (AUI), and on behalf of East Asia by the
National Astronomical Observatory of Japan (NAOJ). The Joint ALMA Observatory (JAO) provides
the unified leadership and management of the construction and operation of ALMA.




Use preferences to customize

- Wal: H—-— Preferences .
Appearance | Colours | Dialogs | Connection | Advanced |
e [ Fontsize 8 00 ' Preferences -
: ) won - D] Sl Font size [12 ] v] Appearance | Colours | |Dialogs | Connection | Advanced |
File| Edit View Tool Search Help Mouse-over Tooltips—————————— -\z;iencle (li(c_wal Sum?aw Vie(‘;vlh— - Colours
: en looking at a Science Goal, show ... _ _ .
a e 32_N Show for secs. O a summary table General—' Spectral Display
i @ all its page editors [ clipboard I Baseband
#-D i
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Editor.UnexpectedError

Export to file. Overwrite existing file?
ExportProject.OverwriteFile
ExportSB.OverwriteFile

Exporting to file. Coordinates out of range —
Exporting to file. Ignoring unsupported coordinates
Exporting to file. Invalid coordinates

Exporting to file. Problem while writing file

IAU lookups are not advised
Import.ConfirmConversion
Import.Overwritelnvestigators
Import.SaveCurrentProject

Server URL https://ote.alma.cl/cycle-3/

J
Show Permissions... ‘

 Connection to Project Repository

FEEEEEEEEEEEEEEEEEEEEEEEE
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e O O A Observing Tool (2014.6) - Bulge Asymmetries and Dynamical Evolution (BAaDE) (2013.1.01180.S last submitted 2014-11-14 17:52:31)
File Edit Vidv | Tool| $arch Help | Perspective 1

E m( A = alibrator Selection Tool... E o [ . . I
: ' —— New: Project-level Total Time and
ulge Asymmetries an

, Data Volume Summary can also be
e seen after right-click on Proposal

n (Isjouwer@nrao.edu)

| o "800
Generate a PDF of Whole P ® = . .
. Total and Calibration Times

ScienceGoal (MSXiiiaRA16b1) Science Goal 12-m Ext. 12-m Compact || 12-m Ext. + Compact || ACA 7-m || ACA TP Overall Non-standard Mode
24 ScienceGoal (MSXiiiaRA16b2) Tot. Cal. Tot. Cal. Tot. Cal. Tot. || Cal. || Tot.||Cal.|| Tot. Cal.
MSXiiiaRAl6al [[51.12 min|(24.75 min|| - - 51.12 min || 24.75 min |[- - - - 51.12 min|(24.75 min||No
MSXiiiaRA16a2 ||51.12 min|[24.75 min [ - - 51.12 min ||24.75 min || - - - |- ||51.12 min|[24.75 min|[No
MSXiiiaRA16a3 ||51.97 min||24.75 min [ - - 51.97 min [[24.75 min |[- - - |- ||51.97 min||24.75 min|[No
MSXiilaRA16a4 [[S1.12 min||24.75 min|(- - 51.12 min ||24.75 min || - - - |[- |151.12 min||24.75 min|[No
MSXiiiaRA16b1(1.29 h 29.95 min||- - 1.29h 29.95 min |[- - - |- ||l1.29h 29.95 min||No
MSXiiiaRA16b2[/1.29 h 29.95 min||- - 1.29h 29.95 min |[- - - |- ||l1.29h 29.95 min||No
q m | D Overall 6.01 h 2.65h - - 6.01 h 2.65h - - - ||- ||6.01h 2.65h
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